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New Features in Logic Pro 8

 

This is an overview of the new features in Logic Pro 8. For more information on these 
features and their use, see the documents mentioned in the following sections.

 

Logic Pro 8 Changes

 

This section provides a summary of new or enhanced Logic Pro 8 features. Further 
details, including usage information, for these functions is found in the 

 

Logic Pro 8 User Manual.

 

Interface

 

The user interface of Logic Pro 8 has undergone a significant transformation. This 
includes general graphical enhancements that improve visibility and make things 
easier to use. Further changes include a number of new, or revamped, windows and 
dialogs, and simplified preferences and project settings. Menu structures have also 
been altered—again, streamlining use.

The changes to the interface have resulted in the renaming of many on screen 
elements, settings, and preferences. This is also reflected in the documentation. See 
“Renaming of Functions and Elements” on page 6, for details on the main changes.

 

New Arrange Window

 

The key change to Logic Pro 8 is a new Arrange window that can incorporate all editor 
windows, the Mixer, and several new windows and on screen elements:
Â

 

Media or Lists area:

 

  This new Arrange window area can be displayed at the right side 
of the Arrange window. It contains all list editors, the Audio Bin, Loop Browser, 
Library, and Browser. See “Media and Lists Area” on page 2.

Â

 

Inspector:

 

  The Inspector is an enhanced replacement for the Parameters area of 
earlier Logic versions. See “The Inspector” on page 3.
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Â

 

Toolbar and Transport bar:

 

  A customizable Toolbar spans the top of the Arrange 
window. It contains buttons that open or close other Arrange window areas, plus 
several function buttons. The customizable Transport bar spans the lower edge of the 
Arrange window. See “Customizable Arrange Toolbar and Transport Bar” on page 4.

Â

 

Editing area:

 

  You can open the Mixer, Sample Editor, Piano Roll Editor, Score Editor or 
Hyper Editor in the Arrange window by clicking the corresponding button—just 
above the Transport bar.

The level of integration between these windows and elements streamline your workflow. 

As examples, you can create a new track (and corresponding channel strip) by dragging 
audio files from the Browser into the Arrange area, or insert an instrument and several 
effects into a channel strip (inclusive of settings) with a single click in the Library.

A further benefit of these new features is that it is (generally) unnecessary to use the 
Environment window for tasks such as channel creation and routing. In fact, setup has 
been simplified to such a degree that the Logic Setup Assistant, and several 
preferences of earlier versions, have been removed.

You can continue to open windows independently, and use screensets as you did in 
earlier Logic versions (although you can now name them). The new Arrange window 
facilities, however, are likely to change your approach.

 

Note:  

 

The screensets of projects created in Logic Pro 7 will be “adapted” to take 
advantage of the new interface features.

 

Media and Lists Area

 

The right-hand side of the Arrange window can accommodate the Lists and Media 
areas. The Lists area is opened by clicking the Lists button in the Arrange Toolbar. It 
contains four sub-windows, accessed by clicking the appropriate tab at the top of the 
area:  the Event List, Marker List, Tempo List, and Signature List. Cosmetically, these are 
a little different to the equivalent windows of earlier Logic versions. There are a few 
small usability enhancements, but overall, they are functionally identical.

The Media area—accessed by clicking the Media button in the Arrange Toolbar—
displays all media files in the project, or on any storage device attached to your system, 
including local network devices. This provides direct access to all available audio files, 
Apple Loops, sample libraries, and more, from the Arrange window. The Media area 
offers four sub-windows, outlined below:

 

Audio Bin

 

A catalogue of all audio files (and regions) in the project. This is the equivalent of the 
Audio window of earlier Logic versions. An enhanced version of the Audio Bin, that 
allows direct region edits, can be opened as an independent window.
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Loop Browser

 

All Apple Loops (and other loop format files, such as ReCycle files) can be browsed or 
searched for, and added to your arrangement. This is an enhanced version of the Loop 
Browser of earlier Logic revisions. 

 

Library

 

The Library is new to Logic Pro 8. It provides access to all settings files—for all channel 
strip, effect, and instrument plug-in settings (including EXS instruments). It can also 
integrate with MIDI devices and (active) ReWire applications, providing rapid access to 
MIDI sub-channels and ReWire instruments.

The Library is intimately connected with the Logic Pro 8 channel strips, and will update 
to reflect the current channel strip type (audio, software instruments, or external MIDI) 
and element selection (Channel Strip Settings menu, Insert or Instrument slot). This 
makes it easy to change channel strip and plug-in settings from the Arrange window, 
which is particularly handy for software instruments.

 

Browser

 

The Browser provides direct access to all supported media files (except settings files 
which are more easily accessed via the Library) on any device connected to your 
computer, including locally networked storage units. It features advanced search 
facilities, making it easy to find any file—even in the largest of media file libraries. Only 
Logic-relevant files are displayed:  Logic projects, OMF, AAF, OpenTL, XML (Final Cut 
Pro), audio files (SDII, AIFF, Wave, CAF, Apple Lossless, AAC, MP3, Apple Loops), MIDI 
files, SysEx files (SYX), and movies. The Browser replaces the Project Manager of earlier 
Logic Pro versions. 

 

The Inspector

 

The Inspector can be displayed by clicking the Inspector button in the Arrange Toolbar. 
It is an enhanced replacement for the Parameters area of earlier Logic versions. The 
actual Inspector content depends on the area in key focus:  either the Arrange or one 
of the editing areas—simply click in an area, on a region or event, on an area title bar, 
menu, tab, or other element to give it key focus. Logic Pro 8 also includes a number of 
new key commands that you can use to quickly switch between areas and windows. As 
an example:  You can use Tab or Shift-Tab to cycle through the Arrange window areas:  
Tab cycles forward, Shift-Tab cycles backwards.

The Inspector basically consists of the parameter area for the window with key focus, 
and the arrange channel strips (see below). If the key focus window does not provide a 
parameter area (Mixer, Sample Editor, Piano Roll Editor, all Media and Lists area tabs), 
the Arrange area parameters are displayed in the Inspector.

If the current project contains a movie file, the top part of the Arrange area Inspector 
(above the Region Parameter box) can display a small movie window.
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Arrange Channel Strips

 

A second channel strip has been added to the Arrange area Inspector, which shows the 
primary destination channel strip for the track channel strip. This enables you to alter 
the settings of the bus (aux channel strip), output, or master channel strip associated 
with a track/channel—without leaving the Arrange window.

 

Customizable Arrange Toolbar and Transport Bar

 

A customizable Arrange Toolbar spans the top of the Arrange window. It contains 
buttons that open or close various Arrange window areas (Media, Inspector, and so on), 
plus other buttons that directly access key functions. You can alter these to meet your 
working needs and methods.

The Transport bar spans the lower edge of the Arrange window. It is completely 
customizable, and features a new Master Level fader, which acts as a remote control for 
the Master fader in the Mixer. Other enhancements include integrated CPU and HD 
load meters, and the Low Latency mode button (see “Software Instrument Live Mode” 
on page 24).

Control-click on either the Toolbar or Transport bar, and choose Customize Transport 
bar/Toolbar from the shortcut menu—to access, and alter, the customization options.

 

Enhanced Bar Ruler Functions

 

The appearance of the Bar ruler can be changed by clicking the small note icon at the 
right-hand edge. This opens a menu of alternate Bar and (SMPTE) Time display settings, 
including the new time linear views. These ensure that grid lines and region lengths are 
altered with tempo changes. (The bar linear views of previous Logic Pro versions 
spaced grid lines and region lengths consistently, even when the project contained 
tempo changes.)

 

To activate a time linear view:
m

 

Choose the Time, or Time and Bar entry from the menu.

 

To activate a bar linear view:
m

 

Choose the Bar, or Bar and Time entry from the menu.

A further setting in this menu is the Marquee Stripe. When activated, a thin row is 
shown at the top of the Bar ruler (see “Marquee Operations” on page 7). 
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Changed Link Behavior

 

The Content Link function is now activated by Option-clicking the Link button (double-
click still works). Control-click (or click-hold) the button to access a shortcut menu, 
offering:  No Link, Same Level Link, and Content Link modes.

 

Piano Roll Editor

 

The Piano Roll Editor Link button now provides only two states:  On and Off. On 
behaves as follows:
Â

 

If you select a single region in the Arrange area, the Piano Roll Editor only displays 
the content of this region—with start and end markers shown in the Bar ruler.

Â

 

If you select multiple regions in the Arrange area, the Piano Roll displays the contents 
of all selected regions.

The new behavior makes the Piano Roll Editor’s Hierarchy button and Show Selected 
Regions Only setting obsolete, so they were removed. 

 

Hyper Editor

 

The Hyper Editor Link button now provides only two states:  On and Off. Switching it 
on activates Content Link:  The Hyper Editor always displays the content of the region 
selected in the Arrange area. The display updates whenever the selection changes.

The new behavior makes the Hyper Editor’s Hierarchy button obsolete, so it was 
removed. 

Further to these changes, the Arrange level view in both the Piano Roll Editor and 
Hyper Editor was removed, as it serves no purpose in the new interface.



 

6

 

 

 

Renaming of Functions and Elements

 

Changes to the interface have brought about a number of terminology changes. Many 
functions, commands, preferences, settings, and alert dialogs have been altered, 
making them simpler and clearer. The following table covers the main changes to on 
screen elements:

 

Arranging

 

Apart from the new look, the Arrange window now offers several features and 
functions that enhance editing operations. You should take a look at “General Editing 
Improvements” on page 8, which covers program-wide changes that also affect the 
Arrange window.

 

Sample Accurate Arrange Editing

 

The Arrange window now allows you to make sample accurate region edits. This is tied 
to the zoom level and Snap menu. In order to make sample-accurate edits:
Â

 

A high zoom level must be chosen
Â

 

The Snap menu needs to be set to Smart or Samples. 

A further, associated, enhancement is the ability to snap automation 

 

edits

 

 with sample-
accuracy, and an automation offset facility (see “Snapping Automation to Grid Values” 
on page 17.)

 

Former term New term

 

audio object channel strip 

audio instrument software instrument

multi channel software instrument multi output software instrument

Parameters area Inspector

Matrix Editor Piano Roll Editor

Audio window Audio Bin

Track Mixer/Audio Mixer Mixer

Global view (Track Mixer) All view

Audio layer (Environment) Mixer layer

song position line (SPL) playhead

song project

drop recording punch recording

format value (Transport bar) division value

Crosshair tool (Hyper Editor) Line tool

Instrument Set (Score Editor) score set

Score Style staff style
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Marquee Operations

 

The new Bar ruler marquee stripe can be used as a selection and navigation tool. When 
activated, a thin marquee stripe is shown at the top of the Bar ruler. You can simply 
drag in this area to create a marquee.

 

To activate the marquee stripe:
m

 

Click the note icon at the right-hand end of the Bar ruler, and choose the Marquee 
setting from the menu. 

 

To make a marquee selection:
m

 

Click-drag in this area to create a marquee stripe selection area (also shown on selected 
Arrange tracks). 

 

To remove the marquee selection:
m

 

Click outside the marquee selection. 

 

To add or remove individual tracks from the marquee selection:
m

 

Shift-click on track names in the track list. 

 

Snap to Transient

 

You can extend or reduce the length of the marquee selection by moving the start or 
end point of the marquee to:
Â

 

Transients in audio regions
Â

 

Note on or off positions in MIDI regions
Â

 

Region start or end positions

 

To change the marquee start or end point:
m

 

Use the Left/Right Arrow keys to move the marquee 

 

end

 

 point. 

These are the default Select Previous (or Next) Region/Event key commands, which 
behave as described above, dependent on the type of region selected (when the 
marquee stripe is visible).

m

 

Hold Shift while using the Arrow keys to move the marquee 

 

start

 

 point.

These are the default Toggle Previous (or Next) Region/Event key commands, which 
behave as described when the marquee stripe is visible.

 

To move the entire marquee, either:
m

 

Press Shift-Home, the default Select First key command.

m

 

Press Shift-End, the default Select Last key command.
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Graphical Time Stretching of Audio Regions

 

You can now visually time stretch or compress an audio region directly in the Arrange 
area:  Simply Option-drag its end into the desired direction. The processing uses the 
currently selected Time Machine algorithm. 

 

New Junction Tool

 

The new—automatically activated—Junction tool allows you to quickly resize two 
adjacent regions:  Simply position the mouse pointer over the 

 

upper

 

 right corner of a 
region that is followed by an adjacent region (or the upper left corner of a region that 
is preceded by an adjacent region). Drag to the left or right to resize both the selected 
and adjacent region.

 

Waveform Zoom Slider

 

The new Waveform Zoom button (beside the horizontal zoom slider) accesses the 
Waveform Zoom slider in the Arrange window. This vertically zooms the waveform 
within audio regions, without actually resizing the region, making sample accurate 
edits easier. 

 

General Editing Improvements

 

There are several enhancements that make access to editing tools and operations 
easier. Coupled with these are new Snap menu settings, which enable you to make 
edits with more precision and speed.

 

Snap Menu Additions

 

The Snap menu offers three new settings:
Â

 

Snap to Absolute Value:

 

  Activate to snap edits to an absolute (not relative) value—
resulting in a snap to the beginning of a bar, for example, when Bar is chosen in the 
Snap menu.

Â

 

Samples (Arrange window only):

 

  Choose to snap edits with sample accuracy. Sample-
accurate edits are directly tied to the zoom level. In other words, you need to zoom 
in to a high magnification level (using the zoom sliders), before a sample accurate 
snap can occur. If the zoom level is too low, the snap will intelligently use the highest 
possible snap resolution, based on the zoom level. 

Â

 

Snap Automation:

 

  Activate to snap both track-based and Hyper Draw (region-based) 
automation nodes to grid positions. Automation edits always snap to an absolute 
position, regardless of whether or not the Snap to Absolute Value option is enabled.
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Shortcut Menus

 

Throughout the application, you can access contextual shortcut menus within editing 
areas (and other areas, such as the Bar ruler and track list) by Control or right-clicking. 
These allow quick access to a number of operations that are specific to the window or 
area. The menu will update to show relevant operations, dependent on selections 
made within the window. To explain, the options available in the Arrange area are 
different when a region is, or is not, selected.

 

Note:  

 

Right mouse button functionality can be changed in the Logic Pro > Preferences 
> Global > Editing tab. By default, this is set to Opens Shortcut Menu. Other options 
are:  Is Assignable to a Tool or Opens Tool Menu.

 

Tool Menus

 

Tools are now selected from the Tool menus shown at the upper-right of windows. You 
can change the currently active tool by clicking on the appropriate icon in the menu. 
The mouse pointer will adopt the shape of the selected tool, making it easy to recognize.

You can also select a second tool—for use via a Command-click. This second tool is 
available when the Command key is pressed while editing. You can also assign the 
right mouse button (if using a multi-button mouse) to a third tool, allowing the use of 
three assignable tools—in each window:
Â

 

Left-click tool: 

 

 Choose this from the left Tool menu.
Â

 

Command-click tool:

 

  Choose this from the right (or center, see below) Tool menu.
Â

 

Right-click tool:

 

  Choose this from the right Tool menu. 

 

Note:  

 

The third Tool menu will only appear when the Logic Pro > Preferences > Global 
> Editing > Right Mouse Button preference is set to Is Assignable to a Tool. By default, 
this preference is set to Opens Shortcut Menu.

As with earlier versions, you can quickly access tools by pressing the Esc key on your 
computer keyboard, which will open a floating Tool menu at the current mouse pointer 
position.
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Advanced Track Creation and Configuration

 

Logic Pro 8 offers a number of facilities that streamline track and channel strip creation.

 

One-Step Region, Track, and Channel Creation

 

Dragging a media file into a blank Arrange area section now creates a new track, and 
corresponding channel strip. 
Â

 

Standard audio files and audio Apple Loops create new audio tracks and channel 
strips.

Â

 

Software Instrument Apple Loops create a new instrument track and channel strip—
and also insert a suitable channel strip setting (an instrument plug-in, and generally 
a few effect plug-ins).

In both cases, a new audio or MIDI region is created at the drop position on the new 
track.

 

New Tracks Buttons and Dialog

 

Two new buttons are found at the top of the Arrange track list. The left button (+) 
opens the New Tracks dialog, which allows you to create as many audio, (software) 
instrument, or external MIDI tracks as needed. The corresponding channel strips (track 
destinations) are automatically created. Advanced options in the New Tracks dialog 
enable you to configure the format and other aspects of the channel strip (mono, 
stereo, record-enabled, multi-timbral instruments, and so on). You can also access the 
New Tracks dialog by choosing Track > New in the Arrange area (or using the 
corresponding key command).

The right button creates a new, empty track that uses the same channel strip assignment 
and settings as the selected track. This is a quick and easy way to create a duplicate of 
an existing track and channel strip, without replicating the data on the track.

 

New Track Header Configuration Dialog

 

The appearance of the track header (the information shown in the track list), including 
naming options, buttons shown, icons, and so on, can now be adjusted in a single 
dialog. Control-click on the track list, and choose Configure Track Header.

 

Changed Track Reassignment Method

 

The track reassignment functionality of earlier versions—click-holding on a track 
icon—has been changed. Control-click on the track list, and choose Reassign Track 
Object to open a hierarchical listing of all available track destinations (MIDI ports and 
sub-channels, or any channel strip available in the Mixer).
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Recording

 

Logic Pro 8 introduces a number of new and enhanced recording functions. These 
include take recording—of both MIDI and audio—and the addition of the Input 
Monitoring button to audio tracks.

 

Takes and Comping

 

Logic Pro 8 provides advanced take management facilities. A take is a recording of a 
part (a guitar solo, for example) that is performed and recorded multiple times. You can 
use takes to record several consecutive versions of a solo, and pick the best one, for 
example. Takes can be made by recording in Cycle mode, or by recording over existing 
regions. You can record both MIDI and audio takes. 

Takes appear as take folders on a single track. You can open the take folder to adjust any 
take region within it. The actual (audio) take recording consists of a single audio 

 

file.

 

Audio takes also form the basis for comping tasks, where the best performances (from 
several takes) are compiled into a single super take. The innovative Quick Swipe 
Comping feature allows you to click-drag across the desired section in a take region. 
This section is automatically deselected in all other takes. This comp will be used as the 
final version of your take. You can not create MIDI comps. 

 

Changed Recording Commands

 

The default Record command initiates recording, as per earlier versions. When used 

 

while recording,

 

 however, it does nothing, and recording continues. The former Record 
behavior (which deleted the recording if used while recording) is named Record/
Record Repeat in Logic Pro 8. 

Control-click the Transport bar Record button to set the Record button behavior. 
Choose Record (default), Record Toggle, or Record Repeat from the menu. 

The new Discard Recording and Return to Last Play Position key command discards the 
running recording, deletes the corresponding files from the Audio Bin, and moves the 
playhead back to the last play position. It differs from Record/Record Repeat in that it 
doesn’t automatically start a new recording immediately. This allows talkback 
communication while Logic Pro is stopped. You will need to manually start a new 
recording (with any Record command). Default key command assignment:  
Command-Period.
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Input Monitoring

 

You can use the new Input Monitoring buttons to monitor audio tracks that are not 
armed. Simply enable the Input Monitoring button on an audio track (or channel strip 
in the Arrange or Mixer windows). This works when Logic Pro is stopped or playing. 

The new Logic Pro > Preferences > Audio > Devices > Core Audio > Independent 
Monitoring Level (for Record Enabled Channel Strips) preference determines whether 
or not an independent monitoring level is available to record enabled audio channels 
(was always available in previous Logic Pro versions). 

 

Note:  

 

The Input Monitoring button is not available on DAE channel strips. They must 
be record-enabled for input monitoring.

 

Support of CAF Files

 

The Recording File Type menu of the Logic Pro > Preferences > Audio > General 
preferences contains the new CAF setting. This recording file type can handle audio file 
recordings larger than 4 GB. 

 

Full Surround Compatibility

 

The surround facilities of Logic Pro 8 now include the following:
Â

 

Surround file importing, recording, and bouncing—in all major surround formats. 
You can also now bounce directly to DVD-A.

Â

 

Surround mixing and plug-in processing:  Many of the integrated instrument and 
effect plug-ins now offer true surround versions. All other plug-ins provide multi 
channel versions that automatically match the project surround format. See the 
individual effect and instrument sections later in this document for details.

Â

 

Multi channel plug-in header and configuration tab—more information in 
“Instrument and Effect Changes” on page 24

Â

 

An enhanced Surround Panner window
Â

 

Surround level metering
Â

 

The ability to encode surround files, through use of the included Compressor 
application. Compressor also includes a number of conversion and batch processing 
tools.

Â

 

A new surround master channel strip
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Mixing

 

As a legacy of the improved surround facilities and new interface, the mixing facilities 
of Logic Pro 8 have changed in the following ways.

 

New Mixer Window

 

Logic Pro 8 unifies the features of the former Track Mixer and Environment Mixer in one 
Mixer window. 

Channel strips are automatically generated when new tracks are created (the File > 
Project Settings > Audio > Automatic Management of Channel Strip Objects setting 
must be active—it is by default). 

The Mixer window also provides a quick way to create new aux channel strips:  Click 
the plus button at the left-hand side of the Mixer window, or choose Options > Create 
New Auxiliary Channel Strips. Both methods open a dialog that allows you to enter 
(and generate) the desired number of aux channel strips.

 

New Mixer Views
The Mixer window offers three new view buttons:  Single, Arrange, and All. These views 
restrict the display to channel strips that are actually needed for the current mixing task.
Â Single view:  The Mixer display is limited to the selected arrange track and its signal 

flow.
Â Arrange view:  Displays all channel strips that correspond to tracks (audio, instrument, 

or external MIDI) used in the Arrange window, and their signal flow. The signal flow 
channel strips are only displayed if the View menu’s Add Signal Flow Channel Strip 
setting is active.

Â All view:  The Mixer displays all MIDI instrument, software instrument, audio, auxiliary 
and master channel strips that exist in your project. 

New Mute and Solo Behavior
The Track Mute/Solo menu in the General Audio preferences offers two choices that 
affect the relationship between track and channel strip Mute/Solo buttons:
Â CPU-saving (slow response):  Mute and Solo states can be independent for tracks and 

channel strips (as in previous Logic Pro versions).
Â Fast (remote Channel Strips):  This is the default setting. The Mute and Solo states are 

always identical for tracks and channel strips. This includes all tracks routed to the 
same destination (the same instrument channel strip, for example).
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Improved Aux Channel Strips
The improved aux channel strips of Logic Pro 8 unify the features formerly available in 
ReWire and bus channels. These channel types are no longer used in Logic Pro 8 (but 
are still available, for compatibility with projects created in earlier Logic versions).
Â Buses are available as an input source for aux channel strips. When creating a bus (by 

using a send on any channel strip), an aux channel strip is automatically generated—
with the corresponding bus set as the aux input source.

Â All ReWire buses (audio streams from an active ReWire slave application) will appear 
as possible input sources for aux channel strips. 

Note:  Imported songs/projects—created in earlier Logic versions—which contain bus 
or ReWire objects, are not altered. These channel types are used “as is” in Logic Pro 8 
(no conversion takes place).

Improved Level Meters
The new Logic Pro > Preferences > Display > General > Scale menu allows you to 
switch the level meters between a Sectional dB-linear scale, and an Exponential scale. 
Exponential provides a higher display resolution in the upper level range. Sectional dB-
linear provides the best possible display resolution across the entire level range. 

The Display preferences also allow you to change the order of multi-channel (surround) 
level meters. You can choose from Internal (the default order of the project surround 
format), ITU standard, Centered, and LCR Grouped.

Audio Configuration Window Removed
The Audio Configuration window is replaced by the streamlined I/O Labels window, 
providing all the options you’ll need to work with user-defined channel strip labels.

Improved import facilities make the conversion features of earlier versions superfluous:  
Imported projects (with any native audio configuration) will automatically use the 
active native driver model. See the Logic Pro 8 TDM Guide for more information on 
importing native driver projects into Direct TDM/DAE configurations.

New Send Position
The Send Position menu offers the new Post Pan setting:  If you choose Post Pan, the 
signal is not only post fader, but also post pan. This means that the pan position of the 
send signal on the aux (which needs to be stereo or multi channel) will follow the Pan/
Balance, or Surround Panner position of the channel strip. 

Color coding makes it easy to identify send position/routing.
Â Post-fader send slots are blue. 
Â Pre-fader send slots are green.
Â Post-pan send slots are orange.
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Binaural Panner and Post-Processing Plug-in
The output menu of audio and instrument channel strips now offers the Binaural 
setting:  When you activate it, the channel strip pan/balance control is replaced with a 
Binaural Panner. The Binaural Panner is a psychoacoustic processor that can simulate 
arbitrary sound source positions (including up and down information) by means of a 
standard stereo signal. This emulates human hearing, which is capable of interpreting 
positional information (where a sound is coming from), despite the fact that only two 
“receivers” (your ears) are used to capture the sound.

The Binaural Post Processing plug-in is only available in aux and output channel strips. 
It is inserted like any other plug-in (from the Imaging sub-menu). This plug-in allows 
you to apply various compensation modes on a stereo bus or output—through which 
several, or all, binaurally panned channel signals are routed. This saves CPU power, and 
makes it easy to switch between compensation modes.

New Channel Strip Setting Commands
The Channel Strip Setting menu offers two new commands:
Â Reset Channel Strip 
Â Delete Channel Strip Setting

Templates and Project Handling
Project handling has been streamlined in Logic Pro 8, making the creation and 
management of new (or existing) projects faster and easier.

Templates
A new, simple to use, Templates dialog is available. A number of factory-supplied 
templates are offered as starting points for different project types. You can save any 
project as a template.

New Startup Action Menu
You can configure Logic Pro to open or create projects automatically—on startup—by 
choosing a startup action in the Logic Pro > Preferences > Global > Project Handling 
tab.
Â Do Nothing:  As the name suggests, nothing happens when you open Logic Pro. You 

will need to create a new project, or open an existing project or template to begin 
work.

Â Open Most Recent Project:  Automatically opens the project you were working on 
when you last quit Logic Pro.

Â Open Existing Project:  Automatically shows the Open dialog, allowing you to browse 
for an existing project.

Â Create New Project from Template:  Automatically opens the Templates dialog.
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Â Create New Empty Project:  Automatically loads an empty project and opens the Save 
As dialog, allowing you to name and save your project. 

Â Create New Project using Default Template:  Automatically opens the default template, 
and launches the Save As dialog, allowing you to name and save your project. Any 
project can be defined as the “default” template. This is the equivalent of the 
Autoload of earlier Logic versions.

Note:  The default song of earlier versions (a plain vanilla project) can still be accessed 
by holding Option when you choose File > New. In Logic Pro 8, this generates a new, 
blank project, and automatically launches the New Tracks dialog.

Removal of the Project Manager
A legacy of the changes to Logic Pro 8 is the removal of the Project Manager, found in 
earlier versions. This functionality has been replaced by the Browser (see “Browser” on 
page 3), Library (see “Library” on page 3), and streamlined project save options.

Enhanced Project Assets Handling
You can save any, or all, of the following types of project assets in the project folder:  all 
recorded (and imported) audio files, EXS instruments (and samples), Ultrabeat samples, 
SpaceDesigner impulse responses, and movie files.

These options are found in the standard project Save or Save As dialogs. Simply click 
the Include Assets checkbox, and enable the desired checkboxes in the Advanced 
Options. The assets are also available as project settings.

You can change and save the project assets at any time. 

Longer Project Length
Logic Pro 8 features a new internal event clock format which allows for much longer 
project lengths. At a normal tempo, this is around 12 hours.

Project Compatibility
Projects saved in Logic Pro 8 are not backwards-compatible with earlier Logic versions 
(due to the new internal clock format).

Projects saved in Logic 5.x, 6.x, or 7.x format can be imported into Logic Pro 8.

Older songs (saved in Logic versions 4.x or earlier) need to be opened and saved in 
Logic 5, 6, or 7 before they can be opened in Logic Pro 8.

Changed Auto Backup Behavior
When you save a project, Logic Pro 8 automatically makes a safety copy (a backup) of 
the project file. Backup files are saved in the project folder, and are named after the
project, but feature the “~” character after the project name. The Auto Backup 
preference was removed.
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Changed Close Behavior
Closing all open windows now automatically closes the open project. A dialog allows 
you to save and exit the project, exit the project (without saving) or cancel the 
operation.

Opening MIDI Files
When you open a MIDI file in Logic Pro 8, software instrument tracks are automatically 
created for each MIDI track, and an appropriate GarageBand instrument is assigned to 
each.

If you want to use external MIDI tracks/devices (rather than GarageBand instruments) 
for each track in the MIDI file, press Option while opening it.

Automation
Logic Pro 8 enhances the automation facilities of earlier versions in the following ways:

Creating Nodes at Region Borders
The Options > Track Automation menu includes two new commands for the creation of 
automation nodes at region borders:
Â Create 2 Nodes at Region Borders
Â Create 4 Nodes at Region Borders

Snapping Automation to Grid Values
A new Snap menu setting allows you to snap both track-based and Hyper Draw 
(region-based) automation nodes to grid positions. To do so, simply enable Snap 
Automation in the Snap menu. 

Note:  Automation edits always snap to an absolute position, regardless of whether or 
not the Snap to Absolute Value option is enabled.

Offsetting Automation
The new Snap Offset parameter in the Automation preferences allows you to move 
automation data slightly forwards or backwards in time (in tick values), when Snap 
Automation is enabled. This can also be activated directly in the Snap menu. 

Following activation of Snap Offset, all automation data that you create from this point 
onwards will be offset by the set number of ticks (on tracks or regions containing 
Hyper Draw automation).

Automation Tool Changes
You can now access the two modes of the Automation tool as separate tools:
Â The Automation Select tool replaces the former Automation tool Select mode.
Â The Automation Curve tool replaces the former Automation tool Curve mode. 
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Automatic Track Creation
If you enable any of the automation write modes on a channel strip that is not used by 
a track in the Arrange window, a new track (and automation lane) will be created.

Improved Global Track Functions
The global tracks have been enhanced as follows:

New Configuration Dialog
The global tracks settings found in the View menu of earlier Logic Pro versions have 
been changed. All individual track view settings are now accessed via the View > 
Configure Global Tracks command (also available by right-clicking in the global tracks 
header area). The Configure Global Tracks dialog is opened, providing checkboxes for 
each global track type, along with Enable All and Disable All buttons.

New Beat Mapping Dialog
The (Detection) Sensitivity menu in the Beat Mapping track header now offers values 
ranging from 0 to 99. Click-drag vertically, or double-click and type in a new value. This 
affords extra precision, resulting in much better analysis.

Clicking the Beats from Region button opens a new dialog. You can choose the note 
value, as per earlier versions, and can also choose one of the two algorithms available 
for analysis of the region.
Â Tolerate missing or additional events:  This new algorithm does what it says. You 

should use this algorithm for audio regions. 
Â Use all existing notes:  This algorithm detects every transient. Use this algorithm (from 

earlier versions) for MIDI regions that provide a note for each transient.

Marker and Signature Alternatives
The header area of the global Marker and Signature tracks now contain an Alternative 
menu. This works much like the Tempo Alternative menu, allowing you to create up to 
nine discrete alternate marker and signature tracks—each containing a different set of 
markers or signatures. 
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Sharing Logic Pro Data Over a Network
Logic Pro 8 allows you to share or back up the following data types over a network:
Â Plug-in settings
Â Channel strip settings
Â Key command sets

This makes it easier to collaborate with other Logic Pro users. Your data can be shared 
or backed up:
Â Via a local network—using Bonjour.
Â Over the Internet—using .Mac (requires a .Mac account).

Distributed Audio Processing (Nodes)
Management of Nodes is now much simpler. Once a Node is set up and enabled for 
use with a host, you can break the network connection or shut down the Node—
without causing problems on the host side. As soon as the Node is up again, it will 
automatically re-establish its connection to the host and be ready for use. 

A new Sync Pending node button state has been added—to indicate a situation where 
data synchronization between the host and node hasn’t been completed.

Audio Unit Effect Processing
Logic Pro 8 allows the processing of Audio Unit effects on Node computers. 

Note:  Audio Unit effect plug-ins need to be installed properly (including any copy 
protection mechanisms) on all Node computers.

You can disable the Node processing for incompatible Audio Unit effects in the Audio 
Units Manager.

Notation
The Score Editor provides a number of new features and functions.

Renaming of Existing Elements
Instrument Sets were renamed to score sets. Score Styles are now named staff styles. 

Staff Style Window:  Key Range Parameter
The new Staff Style window allows you to define a staff style’s key range:  Notes that 
fall outside the key range are not displayed in the Score Editor. This enables you to hide 
notes that are used for key switching duties (as an example, VSL sample libraries loaded 
into the EXS24 mkII).
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Resizing a Staff’s Meter
The new Size parameter in the Clefs & Signatures tab of the Score project settings 
allows you to alter the appearance of the meter (often much larger, for conducting 
purposes) on the staff. It is expressed as regular and percentage values. Single systems 
show both numbers (4/4, for example) on the system. Double systems show the upper 
number on the upper system, and lower number on the lower system.

Fixing the Score Quantize Value
You can now use the Functions > Quantization > Fix Displayed Note Positions and Fix 
Displayed Note Positions and Durations commands to “freeze” the display quantization 
of all MIDI events in the project. These commands may be useful for exporting projects 
(complete with display quantize settings) to other notation programs that don’t feature 
display quantization.

Page Break and Line Break Symbols
The Part box includes the new break symbols group, offering:  Line Break, Page Break, 
No Line Break, and No Page Break events. Once inserted, they can not be moved 
automatically (when you alter the Layout project settings, resize the window, and so on).

You can, however, overrule the positioning of Line Break, Page Break, No Line Break, 
and No Page Break events with the Layout tool.

Line breaks and individual staff margins can be determined for each score set, and also 
for each of the extracted parts.

Importing Text Styles
You can now use the Import Settings function to import score text styles. Simply 
choose File > Project Settings > Import Settings and click the Text Styles checkbox at 
the bottom of the Import Settings window. 

Slur and Tie Thickness
The Slur and Tie Thickness parameters (File > Project Settings > Score > Layout tab) are 
now affected by the Scale parameter in score sets, and the Size parameter in staff styles. 

Improved Tuplets Window
The Tuplet window now contains the Allow Half Values checkbox. If this option is 
activated, N-tuplets can contain note values that are half the length of the regular 
tuplet value. 
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Key Command Changes
Logic Pro 8 introduces a number of new key commands:  for new functions and 
operations, and also to cater to interface changes. It goes without saying that many 
existing key commands have been renamed to match changed elements, functions, 
and commands in the application.

Removed MIDI Commands Learn Functionality
The MIDI Commands Learn functionality (found in the Key Command window of earlier 
versions) has been removed. Assignment of MIDI events or data to Logic Pro 8 
commands and functions is now performed in the Controller Assignments window.

Presets and Export
A Presets submenu has been added to the Options menu, allowing you to quickly 
choose between all key command sets saved in the ~Library/Application Support/
Logic/Key Commands folder. 

The new Export command enables you to quickly export your current key command 
set to any desired location.

Control Surfaces Support
This section provides a summary of the Logic Pro 8 control surface support features. 
For more information on these features and their use, see the Logic Pro 8 Control 
Surfaces Support manual.

Renaming
Â Multi Channel and Channel Strip view are now named Mixer view and Channel view. 
Â Track mode is now named Channel Strip mode.
Â The Track View Mode menu is now named Channel Strip View mode; it offers the 

three new Mixer views—Single, Arrange, and All—plus Tracks (the former Arrange 
view mode).

Bypassing Control Surfaces
You can now temporarily bypass your control surfaces by choosing Logic Pro > 
Preferences > Control Surfaces > Bypass all Control Surfaces. This is useful for silencing 
motorized control surface faders, when recording in the same room. It is also handy 
when troubleshooting MIDI data errors, or to reduce MIDI bandwidth requirements.

The new Logic Pro > Preferences > Control Surfaces > Preferences > “Bypass All while in 
background” preference allows you to share your control surface with other 
applications, when Logic Pro 8 is not the active program. 
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New Touching Fader Selects Track Checkbox
The Logic Pro > Preferences > Control Surfaces > General tab includes the new 
“Touching fader selects track” checkbox:  When active, touching a fader on the control 
surface selects the corresponding track. 

Note:  This functionality only applies to devices with touch-sensitive faders.

Simplified Easy Mode
The Easy view of the Controller Assignments window has been updated, making basic 
control surface assignment tasks much simpler and faster.

Audio Hardware Support
The following outlines changes to audio hardware support in Logic Pro 8.

Enhanced Apogee Hardware Support
The dedicated Apogee control panel of Logic Pro 8 has been enhanced; you can now 
control Apogee’s Duet hardware, in addition to the Apogee Ensemble hardware. Please 
refer to the Logic Pro 8 Working With Apogee Hardware document for further information.

Choosing Playback Hardware
The Sample Editor, Audio Bin, and Browser allow you to audition your audio through 
specific hardware. By default, this uses Core Audio. Control-click on the Prelisten button 
(indicated by the speaker icon) to change the output to different hardware. 

Technically, a new Prelisten channel strip is created in the Mixer (using a higher 
numbered channel strip than exists in the project). If prelistening through DAE 
hardware, the highest numbered (possible with the current hardware configuration) 
channel strip is used.
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Environment
The new interface has resulted in a few small changes to the Environment window.
Â The Audio layer has been renamed to the Mixer layer.
Â A new View > Frameless Floating Window command has been added. This allows you 

to set up a resized Environment layer which can be opened as a (generally small) 
floating window within a screenset. The menu bars and other elements are removed 
from the floating Environment window, thus minimizing screen space usage. An ideal 
and typical use would be for an MMC control panel.

Â The New > Audio Object item has been replaced with a Channel Strip sub-menu 
item. You can create new audio channel strips (audio, software instrument, aux, and 
so on) by choosing the appropriate entry. In general, you should not need to do this, 
given the track/channel strip creation facilities available in the Arrange window.
The bus and input channel strips (objects) can still be created via this menu. These 
are functionally identical to those found in earlier versions, and are primarily retained 
for compatibility with pre-Logic Pro 8 projects. The features they offer are directly 
available in audio and aux channel strips, which offer more flexibility.

Video
A new Follow Tempo option has been added to the Video project settings. When this 
checkbox is activated, you can set a basis tempo in the numerical field below. As the 
name suggests, this allows video to follow tempo changes made in Logic Pro 8.
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Instrument and Effect Changes
This section provides a summary of the Logic Pro 8 instruments and effects features. 
For more information on these features and their use, see the Logic Studio Instruments 
and Effects manual. General changes that affect the application-specific use of plug-ins 
are described in the Logic Pro 8 User Manual. 

General
This section outlines several changes that impact on the use of all effect and 
instrument plug-ins in Logic Pro 8.

Using Multi Output Instruments
Set up of multi output instruments in Logic Pro 8 has been simplified:  When you insert 
a multi output instrument plug-in into an instrument channel, a + button appears at 
the bottom of the channel strip. 

Click this button, and an aux channel strip appears to the right of the instrument 
channel, already assigned to the inserted multi output instrument. Repeat this step to 
create further (automatically assigned) aux channel strips, up to the maximum allowed 
by the instrument plug-in.

Following the creation of the first aux channel strip for your multi output instrument, a 
“–” button appears beside the “+” button. Click the “–” button to remove aux channels.

Software Instrument Live Mode
Software instruments that are live (ready for playing) require considerably more CPU 
power than those that are merely playing back existing regions. To streamline CPU 
usage, selecting a software instrument track in Logic Pro 8 will not immediately switch 
into live mode. It will only switch to live mode after receiving a live MIDI event. The 
Record Enable button of instrument tracks reflects the current status.

Note:  Starting a recording will immediately switch the instrument into live mode (as in 
Logic Pro 7). You can also directly click the Record Enable button of an instrument track 
to switch it to live mode.

New Low Latency Mode
Low Latency mode limits the maximum delay time caused by plug-ins. Plug-ins are 
bypassed to ensure that the maximum possible delay (across the entire signal flow of 
the current track) remains under the chosen value. This mode is handy when you need 
to play a software instrument (or monitor through an audio channel) when high-latency 
plug-ins are in use—at any point in the signal flow for the selected track/channel.

The maximum delay time is set in the General tab of the Audio preferences. Low 
Latency mode is activated with the Low Latency Mode button in the Transport bar, or 
the checkbox in the General Audio preferences tab. 
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New Effect Interfaces
The user interface of all “blue” effect plug-ins has been enhanced, making them easier 
to use. The interface of the Multipressor has also been streamlined, simplifying its use. 

New Plug-In Header
The plug-in header (for all plug-ins) has also been redesigned. It is clearer to read, and 
now provides Previous and Next (plug-in setting) buttons. A Compare button has also 
been added, making it easy to switch between edited/unedited plug-in parameter states.

Multi channel surround versions of plug-ins display a further set of buttons in the plug-
in header. These provide access to surround routing and configuration options for the 
plug-in.

Simplified Plug-in Menu
Two levels of the plug-in menu hierarchy have been removed, making it faster to 
browse, and select, plug-ins. You can now directly click on a plug-in name to insert it, 
rather than choosing mono/stereo. This will automatically insert a plug-in variant that 
best matches the channel (input and output) format.

Redesigned EXS24 mkII Instrument Editor
The redesigned Instrument Editor of the EXS24 mkII offers a more intuitive user 
interface, which enhances usability. Features of note now include graphical editing of 
group and zone velocity ranges. 
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Ultrabeat
Ultrabeat has received a number of new, or enhanced, facilities with the Logic Pro 8 
update.

Step Automation
A new Edit Mode switch engages Ultrabeat’s step automation mode. Step automation 
allows you to program several parameter changes—per step—for each drum sound. 
You can automate as many of the available parameters as you wish, per step. The 
sound parameters that can be edited include all functions of the Synthesizer section, 
except the menus (modulation routings and so on), buttons (oscillator type buttons, 
the buttons in the trigger/group section), and Pan/Spread parameters.

Full View Sequencer Grid
Clicking the new Full View button in Ultrabeat’s lower right corner switches the 
synthesizer controls to a large grid, filled with trigger buttons. The large grid displays 32 
trigger buttons—for each of the 25 drum sounds—independent of the currently 
selected sound.

Import of EXS Instruments
You can now use Ultrabeat’s Import function to import sounds from EXS 
instruments:  Ultrabeat reproduces the EXS layout as closely as possible. Layered EXS 
zones are set up as layered drum sounds, using the sample playback mode of Osc 2.

Side Chain Sound Source in Oscillator 1
Oscillator 1 features a new Side Chain mode:  In this mode, Ultrabeat uses an external 
side chain input as the source for Oscillator 1. This allows you to send the signal of any 
audio channel, aux, or live input through Ultrabeat’s filters, envelopes, LFO, and step 
sequencer. 

Accent per Voice
Ultrabeat’s step sequencer now features an Accent button (similar to the Swing button) 
that switches the Accent setting on or off—individually for each drum sound. This 
allows you to accent cymbal sounds, but not the kick drum, for example.

Additional Step Generation Commands
Control-clicking (or right-clicking) one of the trigger buttons in the step sequencer’s 
trigger row now opens the Trigger shortcut menu. This menu offers a number of step 
creation and re-ordering commands, including:  commands to add a step on every 
upbeat or downbeat, to randomize existing steps, or to shift steps by a specific amount. 

New Sample Init Sound
The drum sound shortcut menu (opened by Control or right-clicking on a drum sound 
in the Assignment section) offers a new Sample Init sound. This sound initializes the 
filter and pitch parameters (to neutral settings), which are ideal as a starting point for 
creating sample-based drum sounds. 
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ES2
The ES2 has received a number of new, or enhanced, facilities with the Logic Pro 8 
update.

Surround Features
When inserted as a surround instance, the ES2 extended parameters provide the 
Surround Range and Surround Diversity parameters:
Â Surround Range:  Determines the range of the surround angle. This can be from 0 to 

360 °. Put another way, this determines the breadth of the surround field. You can 
modulate the movement of sounds—within this surround range—through use of 
the Diversity target in the Router.

Â Surround Diversity:  Determines how the output signal is spread across your surround 
speakers. If you choose a value of 0, only the speakers that are closest to the original 
signal’s position will carry the signal. A diversity value of 1 distributes an identical 
amount of signal to all speakers.

Macro View
The section at the bottom of the ES2 interface now allows you to switch the ES2 to two 
macro views:
Â Macro:  Shows a number of macro parameters which affect groups of other 

parameters.
Â Macro Only:  Replaces the ES2 interface with a dedicated (and much smaller) view 

that is limited to the macro parameters.

In macro view, dedicated macro controls make it quick and easy to adjust several ES2 
sound generation parameters simultaneously. This can be done with the mouse, or by 
using knobs and sliders on your MIDI keyboard—just like a hardware synthesizer!

Vector Envelope Improvements
You can now add up to 16 points to the vector envelope’s time axis. The vector 
envelope also features a new shortcut menu, that you can access by Control-clicking 
anywhere in the vector envelope. 

New Random Groups
The ES2 features four new random destinations:
Â Vector Env XY Pad X only
Â Vector Env XY Pad Y only
Â Vector Env Shuffle Times
Â Vector Env Shuffles Times 
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Sculpture
Sculpture has received a number of new, or enhanced, facilities with the Logic Pro 8 
update.

Surround Features
When inserted as a surround instance, Sculpture’s extended parameters feature the 
Surround Range and Surround Diversity parameters:
Â Surround Range:  Determines the range of the surround angle. Put another way, this 

determines the breadth of the surround field. To better explain its use:  Imagine an 
LFO routed to a pickup’s pan position with an amount of 1.0. Setting the LFO 
waveform to sawtooth, and the Surround Range to 360 results in circular movement 
(around the entire surround circle) of the voice output. The Surround Range 
parameter also influences the Key and Pickup spread in the same way.

Â Surround Diversity:  Determines how the output signal is spread across your surround 
speakers. If you choose a value of 0, only the speakers closest to the original signal’s 
position will carry the signal. A diversity of 1 means that all speakers will carry an 
identical amount of the signal. 

In addition, the new Diversity modulation target allows you to dynamically control how 
much the voice output is spread across the surround channels (essentially, just like 
adjusting the diversity parameter in the surround panner).

Surround instances also offer a true surround delay:  The Delay Time Pad converts into 
a pure “groove” pad that controls the delay time relationship between:
Â Left and right channels (speakers) in the horizontal direction.
Â Front and rear channels (speakers) in the vertical direction. 

The Spread parameter is accessible separately as an edit field to the left of the pad.

The Crossfeed control still controls the cross feedback between the delay-lines, but 
offers additional cross feed modes. You can access these in Sculpture’s Extended 
Parameters section:
Â Left-Right 
Â Front-rear
Â Clockwise
Â Counter-clockwise
Â Zigzag

Clearing and Copying Delay Parameters
You can now Control-click the Delay Time Pad to access a shortcut menu which offers 
Clear, Copy, and Paste commands—for delay settings. These can be used to copy and 
paste delay settings between multiple Sculpture instances, or between consecutively 
loaded settings. The Clear command resets the current delay settings.
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New Sustain Mode
The Morph Envelope’s Sustain Mode menu features the new Scan via CtrlB mode:  
When active, the timeline position within the envelope is “disconnected” from real time, 
and you can “scan” the whole time range by using the MIDI controller chosen for Ctrl B. 

EFM 1
The extended parameters of the EFM 1 now offer MIDI controller assignment facilities. 
You can freely assign any MIDI controller, and the amount of modulation, to the 
following two parameters:
Â FM Intensity
Â Vibrato

New Delay Designer
Logic Pro 8 includes Delay Designer, a multi-tap delay that offers up to 26 individual 
taps. Delay Designer provides control over the following aspects of each tap:
Â Level and pan position
Â Highpass and lowpass filters
Â Pitch transposition (up or down) over two octaves

Further effect-wide parameters include synchronization, quantization, feedback, and so 
on. 

As the name implies, Delay Designer offers significant sound design potential. You can 
use it for everything from a basic echo effect, through to an audio pattern sequencer. 
You can create complex, evolving, moving rhythms by synchronizing the placement of 
taps—coupled with judicious use of pitch transposing and filtering. Alternately, you 
can set up numerous taps as “repeats” of other taps, much as you would use the 
feedback control of a simple delay—but with individual control over each repeat. 

You can use Delay Designer on channels with mono, stereo, or surround inputs and/or 
outputs. 

New Echo Effect
Logic Pro 8 includes the simple Echo effect plug-in, that always synchronizes the delay 
time to the project tempo, allowing you to quickly create echo effects that run in time 
with your composition. 
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New Microphaser Effect
Logic Pro 8 includes the simple Microphaser effect, which allows you to quickly create 
swooshing, phasing effects with just three parameters.

Improved Space Designer
The enhanced Space Designer offers full surround compatibility:
Â Space Designer now supports any impulse response format up to 7.1 (including 

B-format).
Â The impulse response library has been expanded, and now offers surround impulses 

from popular places like the Münster Ulm Cathedral or Bavaria Film Studios. 
Â Surround Space Designer instances offer four output sliders. Together, these 

comprise a small surround output mixer.
Â In surround instances, the Input slider turns into a LFE to Rev slider. This determines 

the amount of LFE signal that is mixed with the surround channels (which are) 
feeding the reverb.

Space Designer also includes a new 4-band EQ—two parametric mid bands, a low 
shelving, and a high shelving filter. You can switch the former Envelope display to show 
the EQ curve. This allows you to edit the SpaceDesigner EQ graphically, as you would 
with the Channel or LinearPhase EQ.

Space Designer Impulse Response Utility
Space Designer’s Deconvolve facilities have been expanded, and are therefore now 
available as a separate application, accessible in the Applications/Utilities folder. The 
Impulse Response Utility is a multi-track audio recording and deconvolution 
application. It allows you to create your own mono, stereo, and surround impulse 
responses for the Space Designer reverb. For full details, see the Impulse Response Utility 
User Manual.

Note:  The Deconvolve button has been removed from the Space Designer plug-in 
interface.You can not directly open the Impulse Response Utility from within 
Logic Pro 8.
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Improved Stereo Compressor
The enhanced Stereo Compressor allows you to switch the circuit between several 
models, including:  Platinum, Classic A_R, Classic A_U, VCA, FET, and Opto (optical).

It also integrates a limiter that is triggered by the output—after the gain control. The 
trigger information is used to dynamically adapt the compressor (to perform the 
limiting effect). The result is a musical and fluent transition between compressing and 
limiting.

Another special feature is the Auto button. If engaged, the release time dynamically 
adjusts itself to the audio material. 

Some advanced functions, such as side chain filtering and some analog type coloring/
overdrive parameters, have been added to the extended parameters. A new Mix 
parameter has also been added.

New Surround Effects
Logic Pro 8 includes true surround versions of the following effect plug-ins:
Â Down Mixer
Â MultiMeter
Â Level Meter
Â Compressor
Â Gain
Â SpaceDesigner
Â Delay Designer
Â Modulation effect (Chorus, Flanger, Microphaser, Ensemble, Modulation Delay, 

Phaser, Tremolo)

Match EQ
The surround version of the Match EQ allows individual filter responses per channel, 
using multi-channel templates. Each channel can be edited separately. If the channel 
configuration—of the analyzed and matched audio signal—are incompatible, the 
mono sum of all template channels is used. The LFE Handling button allows you to 
bypass the LFE channel. 

Modulation Effects
Logic Pro 8 also includes surround versions of the following modulation effects:  
Chorus, Flanger, Microphaser, Ensemble, Modulation Delay, Phaser, and Tremolo.

The LFO cycle phases of these effects are locked, and evenly distributed, across all 
surround channels. 
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The Modulation Delay, Tremolo, and Phaser allow you to control the surround behavior 
with the following parameters:
Â LFO Phase parameter:  Controls the phase relationships between individual channel 

modulations. At 0°, the extreme values of the modulation are achieved 
simultaneously for all channels. 180° or -180° is equal to the greatest possible 
distance between the modulation phases of the channels. 

Â Distribution menu:  Defines how the phase offsets between the individual channels 
are distributed in the surround field. You can choose from Circular, Random, Front <> 
Rear, and Left <> Right distribution. When you load a setting that uses the Random 
option, the saved phase offset value is recalled. If you want to randomize the phase 
setting again, choose “new random” in the Distribution menu.

The Ensemble effect offers the Spread parameter, allowing you to distribute the voices 
across the surround field. 

Note:  The Ensemble effect converts the input signal to mono before processing it. 
Therefore, the Ensemble effect is inserted as multi channel effect in surround to 
surround channels. To access the Surround parameters of the Ensemble effect, you 
need to insert the Ensemble as a Mono to Surround or Stereo to Surround effect 
instance.

Down Mixer
The new Down Mixer plug-in lets you adjust the input format of the surround master 
channel strip. This allows you to quickly check the surround mix in stereo, for example. 

Linear Phase EQ and Channel EQ
The Linear Phase EQ and Channel EQ both feature the new Link button:  It activates 
Gain-Q coupling, which automatically adjusts the Q (bandwidth) when you raise or 
lower the gain on any EQ band, to preserve the perceived bandwidth of the bell curve. 

The Extended Parameter section now offers a Gain-Q-Couple Strength menu:  Setting 
Gain-Q Couple to strong preserves the perceived bandwidth almost entirely, while light 
and medium settings allow some change—as you raise or lower the gain. The 
asymmetric settings feature stronger coupling for negative gain values than for positive 
values. This results in better preservation of the perceived bandwidth when you cut, 
rather than boost, the gain. 

Match EQ
The Match EQ offers the new Fade Extremes menu in the extended parameters:  Choose 
On to smooth the filter curve at the high and low extremes of the frequency spectrum.



AutoFilter
The completely redesigned AutoFilter interface features three new filter state buttons, 
allowing you to switch the AutoFilter between a highpass, bandpass, and lowpass 
characteristic. 
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